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Learning Resources 

The learning resources in this module will help you gain the knowledge required to 
achieve the stated objectives for this course. Please review the text on each page and 
click on the videos provided to access real-world demonstrations. 

Continue
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Technology Resources

The technology that you will need for this course is:

● Computer with reliable internet

● Speakers (for videos and audio)

● PowerPoint

1.To start a free trial for PowerPoint, go to https://www.office.com 

2.Log into your Microsoft account.

3.Click Install to download the setup file to your computer.

4.Double-click the setup file to install all Microsoft Office 365 desktop apps.

If you have any questions or run into problems, you can contact the IT department at (555) 123-4567 
or itdept@fictionalschool.edu

__________________________________________________________________________________________________

https://www.office.com/


This course will provide you with the knowledge and 
skills you need to create online presentations. 

Familiarize yourself with the course overview on the 
next page so you know what to expect. 

Please click the “Continue” button below once you’re 
ready to go to the next page.

Continue

Welcome to the Fundamentals of 
creating an online presentation 
using PowerPoint!
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Alt text: A person looking at a computer screen 
eager to learn.
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Creating a Presentation Using PowerPoint

Lesson Learning Objective Time What’s included

1: Starting Your Presentation The learner explains how to start  

a presentation on PowerPoint. 

10 minutes 1 video

1 quiz

1 discussion board

2: Building Your Presentation The learner explains how to build 

a presentation on PowerPoint. 

10 minutes 1 video

1 quiz

1 discussion board

3: Adding Multimedia Elements The learner explains how to add 

multimedia elements on 

PowerPoint. 

10 minutes 1 video

1 quiz

1 discussion board

4: Putting it All Together The learner creates a PowerPoint 

presentation that includes 

multimedia elements.

30 minutes Final assessment

Peer Reviews

Course Organization

(audio)
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What is PowerPoint?

●  A presentation software program that 
allows users to create professional-
looking slideshows.

Why use PowerPoint?

●  It allows the presenter to convey 
information in an organized and 
engaging way. 

●  This helps keep the audience focused 
in a virtual setting.

Introduction

Back
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Alt text: An outline of a person’s head filled 
with puzzle pieces, which are placed where 
the brain usually is.
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Lesson 1: Starting Your Presentation

●  First, we will begin creating our 
presentation by launching 
PowerPoint. 

●  Next, we will select a theme. 

●  Please click the “play” button 
on the video below, which 
includes a demonstration of 
how to navigate through 
PowerPoint.

Back
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Lesson 1 Transcript

When you first launch PowerPoint, you will have the chance to select from a 

blank template or a catalog of themes. If you select “Blank Presentation,” 

then you will have the opportunity to build your theme from scratch. If you 

select “More Themes,” then it will direct you to a search engine where you 

can search for a particular theme. 

However, since this is a beginner’s course, for this demonstration, we are 

going to select “Blank Presentation,” and build our presentation from 

scratch.
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** DESIGN NOTE: This 
transcript will appear below 
the video on page 6 if the 
user clicks on the  “View 
captions transcript” button. 
The transcript will display 
small chunks of text below 
the video as the video plays.



Lesson 1 Audio Description

PowerPoint is open on the screen, and the user is describing how to start a presentation. 

They explain that when you first launch PowerPoint, you will have the chance to select from 

a blank template or a catalog of themes. If you select “Blank Presentation,” then you will 

have the opportunity to build your theme from scratch. If you select “More Themes,” then it 

will direct you to a search engine where you can search for a particular theme. 

However, since this is a beginner’s course, for this demonstration, you are going to select 

“Blank Presentation,” and build our presentation from scratch. The user hovers their mouse 

in the top left corner of the screen and clicks on the "Blank Presentation” button.
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** DESIGN NOTE: The audio description will play when the user clicks the 
“audio description of the video” button that’s on page 6. The audio will say 
the following:
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Lesson 1 Quiz

Back
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How do you create your own theme from scratch?
_________________________________________________________________________________________

Open PowerPoint and select “More Themes”

Open PowerPoint and select “Blank Presentation”

Open PowerPoint and select “Save As”

A

B

C

** DESIGN NOTE: If a user selects an incorrect answer, then 
they will receive immediate feedback as to why the answer is 
wrong. If the user selects the correct answer, they will receive 
immediate feedback as to why the answer is correct.

Chat with instructor

● ● ●

(Interactivity– button)
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Lesson 1 Discussion Board

●

Back
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Creating a Presentation Using PowerPoint

Group Discussion: How to Create a Presentation
_________________________________________________________________________________________

_________________________________________________________________________________________

Discussion Topic: How do you create a theme? What’s the benefit of creating a theme 
from scratch? 

Your response should be 2-4 sentences long. Once you are done, respond to two of your 
peers. This allows you to collaborate for some further discussion about this topic.

Type a response

Submit

(Interactivity– button)
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Lesson 2: Building Your Presentation

●  An effective, organized 
PowerPoint presentation will 
consist of the following 
elements in order:
1. Title

2. Introduction 

3. Body

4. Conclusion 

●  Please click the “play” button 
on the video below, which 
includes a demonstration of 
how to navigate through 
PowerPoint.

Back
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Lesson 2 Transcript

Your first slide will be your title slide. In this slide, you will write the title of your presentation. To do that, you will click 

where it says, “Click to add title.” Your title must be professional, and it must be descriptive enough so that the 

audience knows what your presentation will be about. For this example, we’ll write “Benefits of Choosing ABC 

Logistics” since the goal of this presentation is to sell the product advertised. 

Next, you will add your introduction slide. You can do this by right-clicking on your current slide and selecting “New 

Slide.” We will title this slide “Introduction.” Your introduction slide should consist of a brief overview of what your 

presentation will be about and the key points that you’re going to cover. Be sure to not overwhelm your audience by 

writing a large block of text. Instead, list your information with bullet points. 

Next, you will add your body slides. You can do this by right-clicking on your current slide and selecting “New Slide.” 

We will title this slide “Body.” These slides will be the bulk of your presentation. The body slides of your presentation 

are chunks of information that convey the overall message. This information should be separated into multiple body 

slides to ensure your audience doesn’t get overwhelmed with blocks and paragraphs of text on one slide. Please 

ensure you list your information in bullet points.

Finally, you will add your conclusion slide. You can do this by right-clicking on your current slide and selecting “New 

Slide.” We will title this slide “Conclusion.” This slide will provide a summary that consists of 3-5 bullet points that list 

key details that you shared throughout your presentation.

Page 12 of 25

** DESIGN NOTE:     
This transcript will 
appear below the 
video on page 11 if the 
user clicks on the  
“View captions 
transcript” button. The 
transcript will display 
small chunks of text 
below the video as the 
video plays. 



Lesson 2 Audio Description

PowerPoint is open on the screen, and the user is describing how our first slide will be your title slide. In this slide, you will write the title of your 

presentation. To do that, you will click where it says, “Click to add title.” Your title must be professional, and it must be descriptive enough so that 

the audience knows what your presentation will be about. For this example, we’ll write “Benefits of Choosing ABC Logistics” since the goal of this 

presentation is to sell the product advertised. 

Next, you will add your introduction slide. You can do this by right-clicking on your current slide and selecting “New Slide.” We will title this slide 

“Introduction.” Your introduction slide should consist of a brief overview of what your presentation will be about and the key points that you’re going 

to cover. Be sure to not overwhelm your audience by writing a large block of text. Instead, list your information with bullet points. 

Next, you will add your body slides. You can do this by right-clicking on your current slide and selecting “New Slide.” We will title this slide “Body.” 

These slides will be the bulk of your presentation. The body slides of your presentation are chunks of information that convey the overall message. 

This information should be separated into multiple body slides to ensure your audience doesn’t get overwhelmed with blocks and paragraphs of 

text on one slide. Please ensure you list your information in bullet points.

Finally, you will add your conclusion slide. You can do this by right-clicking on your current slide and selecting “New Slide.” We will title this slide 

“Conclusion.” This slide will provide a summary that consists of 3-5 bullet points that list key details that you shared throughout your presentation.
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** DESIGN NOTE: The audio description will play when the user clicks the “audio 
description of the video” button that’s on page 11. The audio will say the following:
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Lesson 2 Quiz

Back
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How do you add a new slide to your presentation?
_________________________________________________________________________________________

By right-clicking on your current slide and selecting “New Slide” 

By right-clicking on your current slide and selecting “Hide Slide”

By right-clicking on your current slide and selecting “New Comment”

A

B

C

** DESIGN NOTE: If a user selects an incorrect answer, then they will receive 
immediate feedback as to why the answer is wrong. If the user selects the correct 
answer, they will receive immediate feedback as to why the answer is correct.

Chat with instructor

● ● ●

(Interactivity– chat feature)
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Lesson 2 Discussion Board

●

Back

Page 15 of 25

(audio)

(Interactivity– button)
(Interactivity– button)

Creating a Presentation Using PowerPoint

Group Discussion: How to Build a Presentation
_________________________________________________________________________________________

_________________________________________________________________________________________

Discussion Topic: How do you add a new slide to your presentation? How should you 
organize your slides? Why is it important to organize your slides like this? 

Your response should be 2-4 sentences long. Once you are done, respond to two of your 
peers. This allows you to collaborate for some further discussion about this topic.

Type a response

Submit

(Interactivity– button)
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Lesson 3: Adding Multimedia Elements

●  To make your presentation 
more engaging, you should 
incorporate some form of 
multimedia elements in your 
slides. 

●  Multimedia elements consist 
of pictures, videos, and audio.

●  Please click the “play” button 
on the video below, which 
includes a demonstration of 
how to build your 
presentation.

Back
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View captions transcript
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Lesson 3 Video Transcript

When creating a presentation, PowerPoint includes features that allow you to add 

pictures, animation, videos, and audio to your slides. You can add these multimedia 

elements by clicking on the “Insert” tab that’s located at the top of the screen. 

If you want to add a picture, you can click on “Pictures,” and it will give you the option 

to add an image from your device, online, or stock.

If you want to add a video, you can click on “Video,” and it will give you the option to 

add an image from your device, online, or stock.

If you want to add audio, you can click on “Audio,” and it will give you the option to add 

audio from your device or record audio.
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** DESIGN NOTE: This 
transcript will appear below 
the video on page 16 if the 
user clicks on the  “View 
captions transcript” button. 
The transcript will display 
small chunks of text below 
the video as the video plays. 



Lesson 3 Audio Description

PowerPoint is open on the screen, and the user is describing that when creating a presentation, 

PowerPoint includes features that allow you to add pictures, animation, videos, and audio to your 

slides. You can add these multimedia elements by clicking on the “Insert” tab that’s located at the 

top of the screen. 

If you want to add a picture, you can click on “Pictures,” and it will give you the option to add an 

image from your device, online, or stock.

If you want to add a video, you can click on “Video,” and it will give you the option to add an image 

from your device, online, or stock.

If you want to add audio, you can click on “Audio,” and it will give you the option to add audio from 

your device or record audio.
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** DESIGN NOTE: The audio description will play when the user clicks the “audio 
description of the video” button that’s on page 16. The audio will say the following:
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Lesson 3 Quiz
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How do you add multimedia elements to your presentation?
_________________________________________________________________________________________

By clicking on the “Insert” tab 

By clicking on the “Review” tab

By clicking on the “Transition” tab

A

B

C

** DESIGN NOTE: If a user selects an incorrect answer, then they will receive 
immediate feedback as to why the answer is wrong. If the user selects the correct 
answer, they will receive immediate feedback as to why the answer is correct.

Chat with instructor

● ● ●
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Lesson 3 Discussion Board

●

Back
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Creating a Presentation Using PowerPoint

Group Discussion: How to Add Multimedia Elements
_________________________________________________________________________________________

_________________________________________________________________________________________

Discussion Topic: How do you add pictures, videos, and audio to your presentation? 
Why is it important to add multimedia elements to your slides? 

Your response should be 2-4 sentences long. Once you are done, respond to two of your 
peers. This allows you to collaborate for some further discussion about this topic.

Type a response

Submit

(Interactivity– button)



Throughout this section, you have reviewed the 
fundamentals of creating a presentation using 
PowerPoint, which includes:

●  How to open PowerPoint

●  How to create a new theme

●  How to organize your slides

●  How to add multimedia elements

Summary

Back Next
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Alt text: A person excitedly looking at a 
computer screen.



●  For the final assessment, you will create your own 6-slide 
presentation on any topic of your choice using PowerPoint. 
You must include the following items:

1) A title slide

2) An introduction slide

3) Three body slides

4) A conclusion slide

5) Three multimedia elements

●  Once you are finished, you will upload your PowerPoint to 
the database so another learner can peer review your work.

●  Once you receive feedback from a peer, you will make 
corrections and submit your final copy.

Upload
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Continue
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Click on the “Upload” button above once you’ve 
completed your assessment and you’re ready for it to 
be peer-reviewed.

Click on the “Submit” button above once you’ve 
uploaded your PowerPoint and you’re ready for it to 
be peer-reviewed.

Submit

Summative Assessment: Rough Draft

Chat with instructor

● ● ●

(Interactivity– chat feature)



●  For the peer review, you must review one of your 
classmate’s presentations. You will check to see if they 
have the following elements:

1) A title slide

2) An introduction slide

3) Three body slides

4) A conclusion slide

5) Three multimedia elements

●  Be sure to include meaningful, actionable, and 
constructive feedback. 

Peer Review Directions

Page 23 of 25

(audio)

Back (Interactivity– button)
Continue

(Interactivity– button)



●  Reflect on the feedback that you received from the peer reviews and ask 
yourself the questions below: 

1. Did you include all the elements? 

2. What suggestions did your peer give you? 

3. What changes or corrections can you make?

●  Once you reflect on the feedback and make corrections, you may submit your 
final copy.

Submit Final Draft

Upload
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Back (Interactivity– button)
Continue
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Click on the “Upload” button 
above once you’ve completed 
your assessment and you’re 
ready to submit the final draft.

Click on the “Submit” button 
above once you’ve uploaded your 
PowerPoint and you’re ready to 
submit the final draft.

Submit



Page 24 of 25

(Interactivity– button)

End of the Course Survey

Exit Course

Question Response

1.  Do you believe your expectations for this 
course were satisfied? Why or why not?

2.  What was the best thing about this course?

3.  What was the worst thing about this course?

4.  Would you recommend this course to a family 
member or friend? Why or why not?

5.  Please provide advice and feedback on how 
this course can be improved.

6.  Assign a grade to this course (A being excellent 
and F being extremely poor).

Congratulations on completing this course! If you have a moment, please complete the optional end-
of-the-course survey below by typing your responses in the “Response” section. All responses are 
anonymous, and we use the feedback from our learners to find ways to improve.  

(audio)
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